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Introduction
As someone who writes for a living, and who is serious 
about my work, I focus more on words than tools. But I 
can't deny that a good tool helps make writing easier. 

Over the years, I've used a lot of software to churn out 
words. Most of that software no longer exists and I miss 
some of it. But I've never really found a piece of writing 
software that I could take everywhere with me and use with 
any computer or device that I've owned. That is, until I 
discovered Google Drive.

I use Google Drive to do quite a bit of my writing. Not 
everything, mind you, but I do use Google Drive to prepare 
outlines, drafts, completed versions of articles, and a whole 
lot more.

Why do I used Google Drive so much? It’s simple and no 
matter where I am — at home or on the road — and no 
matter which computer or device I’m using, I get can on or  
get access to my writing. All I need is an Internet 
connection and a web browser. And the internet 
connection isn't always necessary (more on this later).

Hold On ... Just What is Google Drive?

Simply put, Google Drive is an online office and 
productivity suite. It's made up of a word processor, a 
spreadsheet, a presentation tool, a drawing application, 
and a tool to make forms. This book focuses on the word 
processor component of that suite.

Being on the web, the documents that you create with 
Google Drive are stored online. You can get to them 
wherever and whenever you have an internet connection. 
And you're not limited to using a desktop or laptop 
computer. I've used Google Drive with my smartphone, my 
tablet, and even with an Android-powered media player. 
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No matter what I was using, I could easily view and edit my 
documents. 

Google Drive — specifically, the word processor 
component that I'm covering in this book — is easy to use. 
It packs the main features that you need for writing and 
formatting your work, as well as for collaborating with 
others. You don't get all the bells and whistles that you find 
in, say, Microsoft Word but Google Drive does enable you 
to:

• Create and edit documents.

• Format text.

• Add tables and images to your documents.

• Share and collaborate.

• Track revisions.

And you can do a lot more.

What Happened Google Docs?

Good question. Once upon a time, Google's web-based 
office suite was called Google Docs. But in the middle of 
2012, Google made some changes to that service. While 
you can still create and edit and collaborate on documents, 
Google Docs has been expanded to include the storage for 
files other than your documents.

That means you can upload PDF files, images, videos, 
Word or LibreOffice Writer documents, and more to back 
them up in case of an emergency. Google Drive can 
automatically convert files from your desktop word 
processor so you can edit them online. You can even use 
the Google Drive app on your smartphone or tablet to view 
or download those files.    
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What This Book Isn't and Is About

This isn't a comprehensive guide that will teach you 
everything about Google Drive. The beauty of Google 
Drive, and what initially attracted me to it, is that it's simple. 
At it's core, Google Drive is easy to use and easy to learn.

Instead, this book guides you through a number of useful 
features and functions of Google Drive. I'm skipping the 
basics and showing you how to use Google Drive not (just) 
as a word processor but as a powerful tool for writing, 
submitting that writing to editors, and collaborating with 
others. You'll also discover how to easily and efficiently 
organize and back up your work. 

Google Drive for Writers consists of the following chapters:

• Some Basics, which guides you through aspects 
of Google Drive with which you might not be 
familiar.

• A Few Useful Features, which outlines five 
features of Google Drive that can help writers work 
more efficiently.

• Using Styles, which explains the importance of 
styles and how to apply and modify them.

• Setting Up Your Page, which looks at how to 
change the page layout of your documents.

• Using and Creating Templates, which shows you 
how to use Google Drive's collection of templates 
and how to create your own.

• Working with Links and Bookmarks, which 
explains how to link to content outside of your 
documents and within them.

• Organizing Your Work, which explains how to 
better organize your documents using folders.
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• Backing Your Documents, which details how to 
get your documents out of Google Drive and on to 
your computer.

• Collaborating with Others, which looks at how 
use Google Drive's collaboration features to 
effectively work on documents with other people.

• Sending Your Work to Editors ... and Others, 
which explains how to email documents from within 
Google Drive.

• Using Scratchpad, which explains how to 
Scratchpad (a useful extension to the Chrome web 
browser) to take notes.

• Taking Notes with Google Keep, which explains 
how to use Google Keep (a dedicated note taking 
tool that's part of Google Drive).

• Working Offline, which discusses how you can 
work on your documents even when you don't have 
a connection to the internet.

• Storing Files, which goes over how to upload and 
save files (not just documents) to Google Drive.

• Using a Spreadsheet to Track Your Writing (and 
More), which shows you how to take advantage of 
Drive's Spreadsheets feature to track your 
submissions, earnings, expenses, and collaborative 
projects.

You Don't Need To Be a Writer

While I wrote this book with writers in mind, you don't need 
to be one to take advantage of the information on these 
pages. Whether you're a writer, a student, a user of Google 
Apps for Business, a small business owner, or just 
someone who wants or needs to put information down on 
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a page, I think you'll find something useful in this book.

Keep in mind, though, that Google Drive isn't for everyone. 
For some people, it's too basic — it doesn't pack the 
features and functionality (whatever that means) that they 
expect from their word processors. But Google Drive 
adheres to the 80/20 rule: 80% of users of any software 
only use 20% of its features. 

Anyway, you can't know if Google Drive isn't for you unless 
you give it a try.

Ready to learn more? Great! Let's get started!
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Some Basics
If you're familiar with Google Drive, you can safely skip this 
chapter. If you're new to Google Drive, you might want to 
read this chapter if only to get the lay of the land.

Let's take a close look at some aspects of Google Drive 
that you might find unfamiliar.

Google Drive Isn't (Just) a Word Processor

It includes a suite of tools: word processor, spreadsheet, 
presentation tool, simple drawing application, and a tool to 
build forms. Google Drive is also a very flexible way to 
store files.

Since this book is aimed at writers, I'll be focusing on the 
word processor portion of the suite. But most of what I 
cover in these pages applies to the other components of 
Google Drive, too.

My Drive

Google Drive doesn't act like the file manager on your 
desktop or laptop computer. While it does let you group 
your files into what are called folders (more about these 
later), all of your documents are literally lumped together 
on the main Google Drive screen. 

That screen is called My Drive and looks like this:
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As you create more documents, the list (obviously) gets 
longer and messier. Worse still, the list isn't sorted 
alphabetically. Instead, the newest documents, or the ones 
that you've worked on most recently, rise to the top. That 
can make finding a specific document a bit difficult, 
especially if you haven't touched it recently.

You can group similar documents together; I'll be 
discussing how to do that in the chapter “Organizing Your 
Work.” But since Google is pretty good with search, they've 
included a nice search engine with Google Drive. It's at the 
top of the My Drive page. Just type a term in the search 
bod, and it will narrow down your the number of documents 
in the list.
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Sorting Your Documents

You can also sort the documents on the My Drive page by 
clicking the Sort menu in the top-right corner.

While My Drive displays the newest, or most-recently 
edited, documents documents at the top of the list, you can 
also sort documents:

• By when they were last opened.

• Alphabetically, by the title of the document.

• By the size of the document (the biggest first, 
followed by smaller ones).

• By their priority.

All but the last one option is easy to figure out. Priority, 
obviously, is how important a document is. Notice that 
there's a star beside the name of each document in My 
Drive. 
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When you click that star, it turns yellow. That marks the 
document as more important than other documents. For 
example, you can set a priority for the documents that 
you're currently working on. By selecting Priority from the 
Sort menu, you can make sure that those documents 
appear at the top of the list on the My Drive page.

The Interface

When you create a new document, you'll notice that the 
Google Drive interface is very familiar. It's similar to most 
of the word processors that you've used in the past. 
Google Drive is a bit more stripped down, though.

Google Drive has fewer features than, say, LibreOffice 
Writer or Microsoft Office. But remember what I said earlier 
about the 80/20 rule? Google Drive has all the basic 
functions you need. Those functions include:

• Styles for headings.

• Text formatting (like bold, italics, and underline).

• The ability to insert lists and tables into a 
document.

• The ability to search and replace text.

• The ability to insert images and links.

• Calculating a word count.
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There are also a number of other useful and powerful 
features, which the subsequent chapters of this book cover 
in detail.

Saving Your Documents

If you look closely at the Google Drive interface, there's 
something that you'll notice missing: a way to save your 
documents. There's no Save icon on the toolbar and 
there's no item for Save under the File menu.  

But don't worry. Google Drive does the work for you. It 
automatically saves your documents after you stop typing. 
It takes a few seconds, and for many people that automatic 
save feature is the one that takes the most getting used to. 
Just keep your eye on the menu bar. When Google Drive is 
saving a document, the menu bar displays the text 
Saving ... When it's done, it displays All changes saved. 

With that out of the way, let's move on to actually using 
Google Drive for your writing.
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A Few Useful Features
I'd like to spend a few pages looking at five features in 
Google Drive. These features, in the greater scheme of the 
application, aren't all that complex or important. But I find 
them useful and think you will too.

Inserting a Page Break

Google Drive doesn't really understand the concept of a 
page. In fact, it tends to fake pages when you're editing a 
document on screen. When you download or send a 
document as a file (these are explained later), the 
pagination might be off. This mainly results in orphaned 
text which can be unsightly.

The solution to this problem is to add a page break. You 
can do that to avoid orphaned text, or to emphatically mark 
the end of one section or chapter of a document that you're 
working on.

To add a page break, position the cursor at the start of the 
block of text before which you want to insert the break. 
Then, select Insert > Page Break.

Getting a Word Count

Most writers work under one or more restrictions. One of 
the most common restrictions is a limit to the number of 
words that we have for an article or a whitepaper or an 
essay. To stay within that limit, getting an accurate word 
count is essential.

To do that in Google Drive, select Tools > Word Count. 
You get a detailed view of the number of words and 
characters, both in the document and in any text you've 
highlighted.
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Inserting a Table of Contents

While I generally don't use Google Drive for longer 
documents, I know a number of writers who do. Usually, 
those are documents are anywhere from 15 to 50 pages 
long. Sometimes longer. A key component in a document 
that size is a table of contents. It provides the initial point of 
navigation through the document.

Add a table of contents by first placing your cursor 
somewhere near the top of your document and either 
pressing Enter on your keyboard or adding a blank page. 
Then, select Insert > Table of Contents. Google Drive 
scans all of the headings in the document and generates 
the table. And, as in a word processor, the items in the 
table of contents are hyperlinked and headings are 
indented. 

Here's a very simple example of a table of contents:
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Notice that icon in the top-left corner of the table of 
contents? Whenever you add another heading, click that 
icon to refresh the table of contents.

When you export your work as, for example, a Word or 
PDF file the table of contents and the hyperlinks are 
preserved. The refresh icon doesn't appear in printed or 
exported files.

Doing Research

Research is a key to strong writing. But jumping away from 
writing to open another browser tab or window to do that 
research can be annoying. It can definitely slow you down.

You can get around that by using the Research feature.

That feature is, essentially, a gateway to Google's search 
engine but one which allows you to quickly the scan search 
results without navigating away from Google Drive. 

There are two ways to use the Research feature. The first 
is to select Tools > Research. The Research pane opens 
in the right side of the Google Drive window.
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Type what you want to research in the search box. You can 
search using Google's search engine or using Google 
Scholar (a database of scholarly literature). You can also 
search for images and quotes.

The second way is to highlight a piece of text in your 
document, and then select Tools > Research. The 
Research pane opens, with some search results already 
displayed. 

For example, while writing an article on social media a 
while back, I needed some background information on 
something called social CRM. I just highlighted those 
words in my document and got some good information 
without leaving Google Drive.
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Defining a Word or Term

Ever run into a word or term that you didn't now or didn't 
quite understand? You might have put it in your document 
yourself, with the caveat that you'd get back to it and add 
some detail later. Or you might be working with another 
writer, and they added the word or term but didn't 
adequately explain it.

To get a definition, all you need to do is highlight the word 
or term and then select Tools > Define. You get a list of 
definitions. 

Let's go back to that article on social media that I 
mentioned earlier. There's one term I kept hearing while 
writing that piece: social graph. My understanding of that 
term was hazy, but I needed to know what it meant to write 
the article. So, I highlighted it and got a handful of useful 
definitions.
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Using Styles
How do you format your documents? I mean, format things 
like headings and body text. Do you highlight them with 
your mouse and then change the fonts settings? Or do you 
use styles?

I'm hoping that you use styles. Styles allow you to apply 
pre-set formatting to elements of your text. Styles provide a 
consistent look and feel to your documents, and are faster 
and easier to apply than manual formatting.

Like every good word processor, Google Drive allows you 
to add styles to your documents. And you should. Using 
styles is faster, cleaner, and more consistent than manually 
applying formatting. 

A Short Rant Before We Continue

One of my few professional pet peeves is the use and, 
more often than not, the lack of use of styles.

People who should know better fall into the trap of not 
using styles in their word processing software of choice. 
Instead, they apply formatting manually — by highlighting 
text and changing the size of a font and making it bold or 
italic. A cumbersome and dirty process.

Why is it a trap? Styles aren’t there just to make a 
document look nice. Styles enforce consistency by 
controlling the size and attributes of fonts, spacing, 
kerning, and more.

Yes, those things are important. And not just to maintain a 
consistent look and feel. Chances are you're sending your 
work to editors and publishers who will pull your document 
into their production workflow. Using styles ensures that 
everything will transition properly into that workflow. 

Not using styles will disrupt the workflow or it will result in 
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bad formatting in the document. Some poor production 
person or another writer will have to go in and fix the 
problems. Having done that more than a couple of times in 
the past, I can say that it’s very annoying.

Thanks for bearing with me. Now, let's continue.

What Styles are Available in Google Drive?

There aren't many. Just the bare minimum of what you 
need to build a document. Like the default styles found in 
most desktop word processors, the styles that are 
available in Google Drive are usable. A bit bland, but 
usable.

Those styles are:

• Title

• Subtitle

• Heading 1

• Heading 2

• Heading 3

• Normal Text
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Applying Styles

Using your mouse, highlight the text whose style you want 
to change — for example, some words that you want to 
turn into a heading. Then, select the styles that you want to 
apply to the text from the Styles list on the toolbar. 

Customizing Styles

The styles that are available in Google Drive are usable 
but bland. You can change aspects of the built-in styles — 
like the font and size of the font, the color of the text, and 
how the text is aligned — very easily. Let's look at how to 
do that.

If you're reading this book on color screen, you'll probably 
have noticed that the headings are red. I chose red 
because it stands out from the black body text. Let's see 
how to do that with a document in Google Drive.

Create or open a document that has several blocks of text 
with the Heading 2 style applied to it. Find the first of those 
blocks of text and highlight it. Then, on the toolbar, click the 
Text color button and find the shade of red labeled RBG 
(204, 0, 0); it's the one in the second column, sixth block 
down.
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Earlier, I mentioned that manually applying formatting is a 
no-no. That's true in most cases, but it's OK if you're 
customizing a style. 

When you make the kind of change that I described above, 
the heading that you highlighted turns red. But only that 
heading. If you want the other blocks of text formatted with 
the Heading 2 style to match, click the Styles list. Then, 
click the arrow pointing to the right beside the style for 
Heading 2 and select Update 'Heading 2' to match.

Remember that the changes you make only apply to the 
document that you're currently working on. If you decide 
that you want to use the changes you've made across all 
of your documents, expand the list of styles and click 
Options. Then, in the menu that flies out, select Save as 
my default styles.
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Setting Up Your Page
As someone who writes, your page is your canvas. And 
depending on what you’re writing, the way in which your 
page is set up can influence the length of your sentences 
or paragraphs, or determine the size of any images and 
diagrams that you want to include in your document.

While Google Drive doesn’t offer you a lot of flexibility in 
the way in which you can set up a page, it does enable you 
to:

• Choose a page size.
• Add a header and/or a footer to your page.
• Insert page numbers and page ranges.

Let’s look at how to do that.

Choosing a Page Size

As with most desktop word processors, the default page 
size of a Google Drive document is 8.5 inches by 11 
inches. If you’re in North America, that usually works for 
most documents. But 8.5 inches by 11 inches isn’t the 
standard paper size elsewhere in the world. And if you’re 
writing the chapters of what will become an ebook, you 
might want to look at a smaller page size.

With Google Drive, you don’t get too many options to 
change the size of a page. And you can’t create a custom 
page size. But the stock page sizes are more than 
adequate for most of what you need to do.
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To change the page size of your document, select File > 
Page setup.

There are two elements in the Page Setup window that 
you’ll want to pay attention to. The first, obviously, is the 
Paper Size list.
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You can select a paper size that fits your needs. And those 
needs might change depending on the type of document 
you’re writing. If you’re in New Zealand and are writing a 
document that will be printed, then you’d choose A4 from 
the Paper Size list. For the ebooks that I write and publish 
as PDF files, on the other hand, I choose B5 (6.93 inches 
by 9.84 inches). More on this in the chapter Using and 
Creating Templates.

The second element that you need to pay attention to is 
the settings for the margins, which add space around your 
pages. Again, the default (one inch all around) is usually 
fine for most purposes. But feel free to play around with 
the margins to find ones that work for you.

Notice the Set as default button in the Page Setup 
window? If you make any changes to the page layout – for 
example, select the A4 paper size and set the margins to 
half and inch all around – and click Set as default, then all 
of your documents in Google Drive will use that paper size. 
So be careful. Click that button only if you really mean it.

Let’s look at some of the other elements of a page that you 
can customize.

Adding Headers and Footers

Headers and footers can be useful tools in laying out a 
page. If you’re not familiar with them, headers and footers 
are spaces at the top and bottom of a page. And those 
spaces are independent of the rest of the page – what you 
put into a header or a footer doesn’t encroach on whatever 
else is on the page.

Headers and footers are generally contain things like page 
numbers (more on that in a moment), a chapter title, the 
name of the author of a book or article, small logos, or 
some other information. The information that you put into a 
header or footer is carried over to each page in a 
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document, providing a bit of visual consistency and 
continuity throughout that document.

Insert a header or footer by selecting Insert > Header or 
Insert > Footer. Google Drive adds a blank space at the 
top or bottom of the page. You can type text into that 
space, format that text, or add an image.

Here’s a header I put together with a small image and 
some text

That example’s quite basic, but with a little imagination you 
can probably come up with something a bit more 
appealing.

Adding Page Numbers and Page Counts

With longer documents, you’ll want to insert a page 
number or a page count into that document. Let’s look at 
how to do that.

Select Insert > Page Number Then, select either Top of 
page or Bottom of page (depending on where you want to 
put the page number). I always put page numbers at the 
bottom of the page.

By default, Google Drive puts the page number on the 
right. You can format the page number by either centering 
it or putting it on the let side of the page. And you can 
change the font and the size of the font.

I’m old fashioned, so I put center page numbers at the 
bottom of the page.

But a page number sometimes isn’t enough. Every so 
often, you might want to give readers an idea of how many 
pages are in a document. I often find this is the case when 
I’m writing business documents. Adding a page count is 
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simple. Just insert a page number to your document. Then, 
click to the right of the page number. Add a space, type of, 
and then enter another space. Finally, select Insert > Page 
count. You’ll wind up with something that looks like this:

Now that you know how to set up a page, it’s time to start 
using it.
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Using and Creating Templates
You’re probably familiar with templates. They’re canned 
page or document designs that have a specific purpose – 
an article, a book chapter, a report, a letter, or a resume.

The idea behind a template is simple: to give a document a 
consistent look, feel, and structure. A template gives a 
document consistency. The bulk of that consistency comes 
from styles, which control the size and attributes of fonts, 
spacing, margins, and more.

Templates don’t just give documents a consistent look and 
feel. They can be useful if you submit electronic 
manuscripts to publishers.

In fact, templates are especially useful if the publisher you 
work with expects an article, a book chapter, or even an 
entire book to have a certain format or layout. Publishers 
will pull your document into their production workflow, and 
using a template ensures that everything will transition 
properly into that workflow. If a template changes, the 
changes will propagate throughout the document 
automatically.

Google Drive puts hundreds of templates at your fingertips. 
Or, you can create your own. Let’s look at how to do both.

Before You Begin

If you plan to use templates with Google Drive, you should 
create a folder (and sub folders below it) for your 
templates. That will make it easier to organize those 
templates.
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I talked about creating folders in the chapter Organizing 
Your Work. When you create a folder for your templates, 
name the top-level folder something like Templates or 
Writing Templates. Below it, create sub folders for the 
types of writing that you do. I use the following sub folders:

• Articles
• Corporate Writing
• ebooks
• Timesheets and Invoices

It only takes a couple of minutes to create that folder 
structure, but it can help you to quickly find a template for a 
particular kind of writing.

Using Google’s Templates

As I mentioned earlier, Google has a library of templates 
(which you can find here). Many of the templates were 
created by the folks at Google, and many were created by 
users of Google Drive. There are templates for documents, 
spreadsheets, presentations, forms, and drawings. Let’s 
focus on the document templates.

Get started by going to Google’s templates site. Click the 
Documents link on the left of the page to get the full list of 
available document templates. I’d only recommend that if 
1) you think you’ll get lucky and find what you’re looking for 
on the first page or three, or 2) if you have a lot of time to 
search. Remember, there are hundreds of templates in 
that collection.

It’s better to use the search box on the page. You might 
have heard that Google’s pretty good at the whole search 
thing … Seriously, though, let’s say you want to write a 
press release. Search for press release. You’ll get a few 
dozen examples – many of the best of them are on the first 
couple of pages of results.
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The nice thing about Google’s templates is that each one 
includes a thumbnail that will give you a general idea of 
what the template looks like when it’s in use.

You can see a template in all its glory by clicking the 
Preview link. Once you’ve found a template that suits your 
needs, click the Use this template button. That adds the 
template to My Drive.

Remember to move the template to a template folder. 
Whenever want to use it, open the template, make a copy 
of it, rename that copy, and then start writing.

Creating Your Own Templates

What happens if you can’t find a template that quite right 
for your needs? You can create a template of your own, or 
modify an existing Google Drive template.

Remember, though, that you don’t have as much flexibility 
when comes to modifying a template in Google Drive as 
you do in a desktop word processor like Microsoft Word or 
LibreOffice Writer. But, for most people, Google Drive’s 
capabilities are more than enough.

Before you start building your own template or modifying 
an existing one, you should think about the design of your 
template. You don’t have to be a graphic artist or page 
layout wizard to do a good job, but you should sketch the 
look of your page or document out on a piece of paper. It 
doesn’t need to be a drawing. It could simply be a list of 
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page attributes. Think about:

• The fonts that you want to use
• The levels of heading
• The colors of the fonts
• The size of the page and the margins.

Once you have that figured out, it’s time to start building 
your template.

An Example: An ebook Chapter Template

I’m going to walk you through how I created the template 
that I use for my ebooks. This section builds on several of 
concepts that I’ve introduced in this book.

When I use this template, I download the individual chapter 
files to my computer, assemble them in a word processor, 
and then create a PDF that I then sell.

My ebooks use the same simple layout:

• The page size is B5 (about 7 inches by 10 about 
inches).

• The body font is 10 point sans-serif.
• I use three levels of heading, all of them red and 

left aligned, and with the following attributes:
• Heading 1 - The font is 18 point Arial.
• Heading 2 - The font is 16 point Arial.
• Heading 3 - The font is 14 point Arial.

• Each page has a footer that contains a page 
number, which is centered in the footer.

Start off by creating a new document. Modify the page 
layout by selecting File > Page Setup. Select B5 from the 
Paper Size list. The default margins are one inch around, 
which is what I use.
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Next, let’s change the font and style of the body and 
heading text. I explained how to do this in the chapter 
Using Styles, but let’s go through it again.

Type Heading 1 at the top of the page, then apply the 
Heading 1 style to it. Highlight the heading, then do the 
following:

• Change the size of the font by selecting 18 from the 
Font Size list.

• Choose Arial from the Font list.
• Click the Text Color button and, from the window 

that pops out, choose the shade of red on the far 
right side of the second row at the top. That red has 
a value of RGB (152,0,0).

Then, highlight the heading again and select Heading 1 
from the Styles list. Click the arrow pointing to the right 
beside Heading 1 and select Update ‘Heading 1’ to 
match.

Repeat that for Heading 2, Heading 3, and the body text.

Finally, let’s add a a page number. To do that, select Insert 
> Page Number > Bottom of page. This adds a page 
number, which will automatically increment, in the footer. 
I’ve always preferred having page numbers in the middle of 
a footer, so highlight the page number and click the Center 
button on the toolbar.

Something that I like to do is put placeholder elements the 
template to show where each element goes. Let’s go back 
to the template that we just built. 
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At the top of the chapter, I include the placeholder 
[Chapter Title], followed by body text stating Begin 
writing here. I do something similar for Heading 2 and 
Heading 3, as you can see below:

When you’re done, save the template to your Templates 
folder. As I mentioned earlier, when you need to use the 
template open it, make a copy, rename that copy, and then 
start writing.

If you’re interested, you find a copy of this template (which 
you can reuse and modify) here.
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Working With Links and Bookmarks
We live in an age of hypertext. With a mouse click, 
anyone can not only jump from one place on the web to 
another, but also to any location within a document they’re 
reading. Sometimes, it’s hard to imagine a world or, at 
least, a document that doesn’t allow you to do that.

Unless you’re writing for print, you’ll probably include at 
least one link in something you’re writing. It might be to a 
website with more information about the subject you’re 
covering. It might be to your Twitter or Facebook page. Or 
it might be a link to another section of the document that 
you’re writing.

No matter what you’re linking to, it’s easy to insert a link in 
Google Drive. Best of all, regardless of what format in 
which you publish your document – as a word processor 
file, a PDF, or as HTML – the links stay active.

Let’s look at how to add links and bookmarks to your 
documents in Google Drive.

Adding Links to a Document

As I mentioned a few paragraphs ago, a link lets a reader 
jump from your document to a place on the web, or to 
another point in the same document. All with the click of a 
mouse.

So, just how do you add a link to a document? Here’s how:

Start off by highlighting the text that you want to turn into a 
link. Say, for example, you’re pointing readers to your 
Twitter page – that text could read, for example, You can 
find news and updates on my Twitter page. Then, select 
Insert > Hyperlink. Doing this opens the Edit link window.
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In the URL for the link field, type the address of the 
website or page that you’re linking to – in this case, the 
URL of my Twitter page.

When you’re done, click OK.

You might have noticed a couple of things about the Edit 
link window. First, you can edit what’s in the Text to 
display field. The second is the link labeled Test this link, 
which lets you make sure that the URL you entered works. 
Clicking the link opens a new window. If the site or page 
loads then all is good. If it doesn’t, fix the link and try again.

Creating an Email Link

Did you notice the Email address option in the Edit link 
window? Instead of adding a link to a website, you can 
create a link using your email address. When a reader 
clicks the link, they’ll be able to send you a message. 
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Clicking the link will open a new message window in their 
default mail program – for example, Thunderbird on their 
desktop or Gmail on the web.

To add an email link, click Email address in the Edit link 
window and then type your email address in the Email 
address for the link field.

There’s a little trick that you can use to add a subject link to 
the message when a reader clicks the link. All you need to 
do is add ?subject=Subject to the end of your email 
address.

So, let’s say I want to create an email link that will include 
the subject line Feedback on your ebook. So, I’d enter 
scott@scottnesbitt.net?subject=Feedback on your 
ebook in the Email address.

Now what about jumping to another place in a document? 
Setting that up takes a little more work. Which is where 
bookmarks come in. Let’s take a closer look at how to use 
bookmarks and links in a Google Drive document.

Adding Bookmarks

In the previous section, I focused on creating links that 
take you outside of your document. If, however, you’re 
writing and publishing for electronic consumption, you’ll 
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probably find that you need to include at least one or two 
links to a place within a document.

You’d do that to, for example, to point a reader to a section 
of the document that contains information that’s related to 
what they’re reading or to a previous section that 
discusses a concept.

But for those kinds of links to work, you need to insert 
bookmarks. Just as you’d use a bookmark to mark your 
place in a dead-trees book, an electronic bookmark is a 
pointer. It tells a link where to go within a document.

Adding a bookmark, and a link to it, in a document is easy. 
Here’s how:

First off, navigate to the point in the document to which you 
want to link. That’s often a heading, although it’s not 
uncommon to link to a paragraph or a place within a 
paragraph.

Next, click where you want to insert the bookmark. If you’re 
linking to a heading, click either the beginning or the end of 
the heading. Then, select Insert > Bookmark.

Now, let’s link to that bookmark. Find the text in the 
document that will act as the link. Select that text with your 
mouse and then select Insert > Link. 

In the Edit link window, click Bookmark and then select 
the bookmark that you want to link to. Click OK to create 
the link.
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Adding links to your documents makes them more 
interactive and gives your readers more options not only 
for navigating around a document but also for accessing 
additional information. Links (and bookmarks) are easy to 
add to a document. But don’t let that ease of use trick you 
into inserting links simply because you can.
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Organizing Your Work
When you first start using Google Drive, you'll notice that 
the way in which your documents and files are saved is 
rather free form. Actually, that's being generous. It's messy. 

All of your documents are literally lumped together in a 
long list on the My Drive page. That's fine if you have a 
few documents or files. But as time passes and you add 
more and more documents to Google Drive, the mess 
increases.

As I mentioned in the chapter Some Basics, Google Drive 
sorts documents and files by the date they were created or 
last modified. You can change the way that Google Drive 
sorts your work but that's not always helpful.

That's where folders come in. Just as you have directories 
and subdirectories for documents on your computer, you 
can create folders for your documents in Google Drive. A 
folder is just like a directory on your computer. It holds 
documents that are somehow related. If, for example, you 
regularly write for a particular publication, you can create a 
folder named after that publication. Folders keep your 
works organized and make it easier to find.

Over the next few pages, I'm going to show you how to 
create and effectively use folders in Google Drive. 
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Creating a Folder

You can create a folderby clicking the Create button in the 
upper-left corner of the page and choose Folder.

You'll be asked to give the new folder a name.

Give your folder a descriptive, meaningful name. A name 
that will easily identify the contents of that folder. Using a 
name like My Writing or Writing Notes isn't the best way to 
go. By doing that, you're just shovelling the mess from the 
top-level list in My Drive into another place. Sure, the 
mess might be smaller but it's still a mess.
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Earlier in this chapter, I gave an example of naming a 
folder after publications to which you regularly contribute. 
That strategy works well. While you might have a large 
number of folders, you'll be able to quickly zero in on your 
work.

I'll be offering a few tips for better organizing your 
documents and files later in this chapter.

Folders Within Folders

In the previous section, I mentioned that using a name like 
My Writing or Writing Notes for your folders isn't the best 
way to go. Well, that's not always the case. You can use 
those names and then create sub folders to further 
organize your writing. A sub folder is merely a folder below 
a main folder in My Drive. 

Let's say that you decide to create a folder called My 
Writing. Under that folder, you can have separate sub 
folders for each publication that you write for, a folder for 
drafts, and another folder for notes.

To create a sub folder, first click the folder in My Drive 
under which you want to create the sub folder. Once you're 
inside the main folder, click the New Folder button on the 
toolbar. From there, give the sub folder a descriptive name. 

You can create as many sub folders as you need. You can 
even add folders to sub folders — doing that, you wind up 
with what techie types call a folder structure. Think of the 
folder structure as a tree. The main folder is the trunk, and 
the sub folders are the branches and leaves connected to 
that trunk. 

I go into more detail about creating effective folder 
structures later in this chapter.
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Moving Documents Into Folders

When you create a new document or upload a file to 
Google Drive, that document or file is is automatically put 
into My Drive. Yes, into that long and messy list. You need 
to manually move your documents and files into folders.

You've probably noticed checkboxes beside the names of 
documents, files, and folders.

Click the checkbox beside the document or file that you 
want to move into a folder. Then, click the Organize 
button.

From there, select the folder into which you want to move 
the document or file and then click the Apply Changes 
button.

47



You can, if necessary, select multiple documents or files 
and move several of them at once.

Using Folders Effectively

As I've stressed throughout this chapter, one of the keys to 
using folders in Google Drive effectively is to give them 
descriptive, meaningful names. Another key is to create an 
effective folder structure.

I've found that the most effective folder structures are 
project-based and task-based. Let's take a look at both of 
those structures.

Project-Based Folders

A project-based folder structure is for a specific, one-time 
project. That could be a writing assignment you're doing for 
a corporate client or it could be for a book that you're 
writing.

Depending on the project, you might have subdirectories 
for images, notes, and the like. Let's say you're writing a 
book. You'd have a main project folder, with a sub folder for 
drafts of each chapter, another for files that have been 
edited, and one for the final approved drafts.

There's an example of a project-based folder structure on 
the next page:
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Task-Based Folders

Earlier in this chapter, I illustrated an example of setting up 
a folder structure for a publication to which you regularly 
contribute. I call that type of folder structure a task-based 
structure. You can use this kind of folder structure, for 
exmaple, to hold blog posts or articles that you write for 
online and print publications.

Let's go back to the example of creating a folder structure 
for a publication to which you regularly contribute. You can 
name the main folder after the publication. Under that 
folder, you can have sub folders for particular years. Under 
the sub folders for each year, you can have sub folders 
named after the articles you've written (or are writing). 
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Here's an example of a task-based folder structure:

Setting up a directory structure to properly manage and 
organize your documents in Google Drive requires a bit of 
work upfront. But once you get into the habit of creating 
and using your directory structures, you’ll find they make it 
easier to manage your writing.
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Backing Up Your Documents
Things happen. Sometimes, those things are bad. Very 
bad. 

With online services like Google Drive, that could mean a 
server problem that wipes out one or a few or all of your 
documents. Or you could get locked out of your account. 
Which means you can't get access to those documents.

On the other hand, you could decide that Google Drive 
isn't for you. As I mentioned in the introduction to this book, 
it's not for everyone. 

No matter what the case, you'll want to regularly download 
copies of your documents to your computer. You can do 
that inside Google Drive by backing up individual files or 
folders. You can also use a service that Google provides to 
save your documents.

Let's look at all of those options for backing up your work.

A Bit About File Formats

The information in this section will become important soon. 
It's definitely worth spending a little time reading what 
comes next.

If you look on your computer, you'll probably see files with 
names that end in .doc, .txt, .pdf, or even .html. The 
.whatever portion of the name of the file is called an 
extension, and that extension identifies the format of the 
file. The format tells software, and you, what program 
created that file. The format also tells software about the 
structure of the file and how to read it.

Why is that important to you? Not all file formats are 
created equally. Not all software can read all file formats — 
a text editor, for example, can't open a file created with 
Microsoft Word. Choosing the right format could be crucial 
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to the integrity and usability of your backups.

In Google Drive, you can export your documents in six file 
formats:

Microsoft Word (.docx): The file format used with 
Microsoft Word version 2007 and later. These files have 
the extension .docx — for example, report.docx. If you're 
using an older version of Word, you can convert .docx files 
to a format using an online tool like Zamzar.

OpenDocument Format (.odt):  The file format used with 
a number of Open Source word processors, notably 
OpenOffice.org Writer and LibreOffice Writer. These files 
have the extension .odt — for example, article.odt.

Rich Text Format (.rtf): This is a word processor file 
format that's been around since 1987. Just about every 
word processor, old or new, supports Rich Text Format. 
These files have the extension .rtf — for example, 
LetterToMom.rtf. While Rich Text Format is good for 
exchanging information, it doesn't retain style information 
like Microsoft Word and OpenDocument files do. 

PDF Document (.pdf): This is a common format for 
archiving and distributing documents like ebooks, reports, 
articles, and more. These files have the extension .pdf — 
for example, BestsellingNovel.pdf. The difference between 
PDF documents and the other file formats is that you can't 
readily edit PDF files. As well, you can't open a PDF file in 
a word processor. You can only view them in a specialized 
application, like the free Acrobat Reader.

Plain Text (.txt): This is a simple file format that you can 
open in software like Notepad, TextEdit, or Gedit. You can 
also open plain text files in any word processor. Plain text 
files have no formatting. In fact, they're pretty bland. But 
they save your words nicely. These files have the 
extension .txt — for example, Newsletter.txt.
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Web Page (.html, zipped): Web pages are written in a 
text-based format called HTML (Hypertext Markup 
Language). When viewed in a web browser like Chrome or 
Firefox, you see the formatted page and not the code that 
makes up the page. When you select this option, Google 
Drive creates a file with the extension .html — for example, 
MyThesis.html — and then compresses it into an archive 
with the extension .zip (for example, MyThesis.zip). If 
you've included any images in your document, those are 
included in the archive as well.

For most people, Microsoft Word (.docx) is probably the 
safest bet. Just about every modern word processor can 
open a .docx file.

Backing Up Individual Documents

Open the document that you want to back up. Then, select 
File > Download As. A small menu flies out. Select the file 
format that you want to save the document as from that 
menu.

Your web browser downloads the file to your computer.

Backing Up Multiple Documents

What happens if you want to back up more than one 
document? Saving them to your computer individually is a 
time-consuming process. To save time, you can download 
multiple files to your computer.
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Go to My Drive. When you're there, click the checkboxes 
beside the documents that you want to back up. Then, 
click the More button at the top of the window and select 
Download.

When you select Download, a window opens that allows 
you to specify how you want Google Drive to backup up 
your documents.

Notice the Document list? In this example, it's set to Open 
Document. You can click the list and choose one of the 
other file formats (which are explained above). Then, click 
the Download button. 
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Google Drive compresses the files into an archive. This 
can take anywhere from a few seconds to a few minutes, 
depending on the number of files that you have selected 
and how large they are. Once the files have been put into 
the archive, Google Drive downloads the archive. It has a 
file name like documents-export-[date].zip — for example, 
documents-export-2012-10-11.zip.

Backing Up Folders

If you've organized your work into folders, you can back  
those folders up. You back up a folder in the same way you 
would back up multiple documents. Go to My Drive and 
click the checkbox beside the name of the folder that you 
want to back up. Then, click the More button at the top of 
the window and select Download.

When you select Download, a window opens letting you 
specify how you want Google Drive to backup up the 
documents in the folder. If, like me, you've added other 
types of documents to your folders, they'll appear in 
formats lists.

In the example above, you'll notice that in addition to 89 
documents, I also have five spreadsheets in the folder I'm 
trying to back up. I use those spreadsheets to track 
submissions to publications and to track the sales of my 
ebooks. In this case, Microsoft Excel is usually the best 
option for saving spreadsheets.

As with exporting multiple files, Google Drive compresses 
the contents of the folder into an archive. This can take 
anywhere from a few seconds to a few minutes, depending 
on the number of files that you have selected and how 
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large they are. Once the files have been put into the 
archive, Google Drive downloads the archive. It has a file 
name like [name_of_folder]-[date].zip — for example, 
Writing-2012-10-11.zip.

Using Google Takeout

What if you want to grab all of your data in one fell swoop? 
You can do that using a service called Google Takeout. 
According to Google, Takeout makes escaping from 
Google products as easy as possible. 

You can choose to download all of your information in 
Google's services, or just data from specific services. 
We're obviously going to focus on getting information out 
of Google Drive.

Go to Google Takeout. Click the Choose Services button 
at the top of the main page. 

You're taken to the Select a service page. Click the Drive 
button. Google Takeout estimates the number of files that 
you have in Google Drive and the size of the download, as 
shown on the next page. 
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Notice the Configure button at the bottom of the estimate? 
Click that to tell Google Takeout what file formats you want 
to use for your backup.

For example, you can export all of your documents as 
Microsoft Word files and all of your spreadsheets as 
Microsoft Excel files.

When you're ready, click the Create Archive button. Just 
as when you exported multiple files and folder in Google 
Drive, Google Takeout compresses the contents of your 
Google Drive into an archive. This can take anywhere from 
a few seconds to a few minutes, depending on the number 
of files that you have selected and how large they are. 
Once the files have been put into the archive, click the 
Download button. Google Takeout downloads the archive. 
It has a file name like [your_gmail_address]-takeout.zip — 
for example, you@gmail.com-takeout.zip.

Keep in mind, though, that Google Takeout is all or 
nothing. It takes everything in Google Drive — all 
documents, spreadsheets, presentations, drawings, and all 
files that you've uploaded to Google Drive — and backs it 
up. Depending on how many documents and files you 
have in Google Drive, that could be a pretty big backup 
file. While writing this book, I did a backup and it weighed 
in at around 24.5 MB. I'm sure it's grown a bit bigger since 
then ...
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Collaborating with Others
Writing is often viewed as a solitary endeavor. The lone 
writer tapping away at a keyboard in a cold garret and all 
of that. While that's how many writers still work (well, 
substitute a dining room table or coffee shop for the 
garret), it's not uncommon for writers to work together. You 
also might be working with clients who want to review or 
edit your work.

That collaboration usually happens at a distance. The 
distance could be a few city blocks or a continent and 
several time zones away. The traditional way of 
collaborating involves sending word processor files around 
by email. When you do that, not-so-nice things can 
happen. Like what? Like files getting lost or corrupted, 
people working on older versions of files, and more.

Using Google Drive, you don't have to worry about that. 
You can collaborate online, and all your collaborators  
need is a free Google Drive account. You have to do a bit 
of set up, but that little bit of work eliminates a lot of 
headaches.

Collaborating on Documents

Before others can collaborate on a document in Google 
Drive with you, you need to share that document with 
them. Sharing a document involves sending your 
collaborators a link (which Google Drive generates) and 
giving them permission to edit the document. 

Open the document that you want to share and then click 
the Share button in the top-right portion of the window. 
This opens the Sharing settings window.
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In the Add people section of the window, type the email 
addresses of the people with whom you want to share the 
document. Notice that beside the box for the email 
addresses is a setting labeled Can edit. If you want others 
to edit the document, leave that as it is. You can also 
change that setting to: 

• Can view - The people to whom you send the link 
can only read the document.

• Can comment - The people to whom you send the 
link can view and add comments to the document. 
More about this soon.

The Can edit setting, as you've probably guessed, allows 
people to view, comment on, and change a document.

Then, click the Share & save button. The person or people 
with whom you are sharing will receive an email with a link 
to the document in Google Drive. 
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Tracking Changes

When you have more than one person working on a file, 
things can happen. Generally, those are good things. But 
every so often, someone might delete a sentence or a 
paragraph that shouldn't have been deleted. Or you might 
decide that something you got rid of a draft or two back 
actually works and which you want to restore. 

In Google Drive, when you delete text it's not gone forever. 
Revision history can save you a lot of time and decrease 
your stress. Revision history is a useful features that 
modern word processors pack, but which not enough 
people use often enough.

Revision history tracks the changes that you made to a 
document. You don't need to enable it; revision history runs 
behind the scenes. Any changes that you make to a 
document are logged to the revision history every time you 
save that document. 

To view the revision history of a document, open the 
document and select File > See revision history. The 
Revision History pane opens on the right side of the 
document window. 

Any changes that were made to a document are marked in 
a sickly green. Often, that's not terribly useful — when you 
open the Revision History pane, Google Drive displays 
all of the changes that were made to the document. The 
entire document will be green. 

It's better to get a view of each revision. To do that, click 
the Show more detailed revisions button at the bottom of 
the Revision History pane. Click on a revision to view it.
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In the example above, the text [title here] was replaced 
with the actual title of the document. Notice that the text 
that was replaced has a line through it. 

Let's look at another example from the same document:

Notice that some text was deleted (it has the line through 
it) and some more text was added. Now, I want to reinsert 
the deleted text. To do that, click the Restore this revision 
link in Revision History pane.

Be careful when restoring a previous revision. It will get rid 
of any work you have done subsequent to that revision.

Adding Comments

If you're collaborating over long distance — whether with 
one or more other writers or with an editor — someone in 
that group might have some questions or suggestions 
about something in the document. Traditionally, you would 
have exchanged emails about that. The problem with doing 
that is you can easily lose your place in an email thread. Or 
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it can be difficult to find exactly where in a document your 
collaborator is pointing out an issue.

It's easier to insert a comment into a document. Just 
highlight the word or phrase or sentence or paragraph to 
which you want to add a comment. Then select Insert > 
Comment. A small text box opens.

Type your comment in the box and then click the 
Comment button. Google Drive highlights the text in 
yellow (making it easy to identify) and adds your comment 
to the margin of the document.

In case you're wondering, Google Drive will send you an 
email to inform you of any comments that were added to a 
document.
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Working with Comments

So, you have a few comments in your document. Now 
what? There are a few things you can do. If it's a simple 
change, you can make the change. After that, you can click 
in the comment in the margin and then click the Resolve 
button. 

The comment, and the highlighting in the text of the 
document, is removed.

On the other hand, if you need more clarification about a 
comment or want to discuss it, click on the comment and 
type something in the Reply to this comment field. Then, 
click the Reply button.
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Google Drive maintains a thread of the replies in the 
margin. You can also view all comments and replies 
(including ones that have been resolved) but clicking the 
Comments button in the top-right corner of the document 
window.

Collaborating at the Same Time

So, what happens if two (or more) people are working on a 
document at the same time. You'd think that would get 
messy, and that one person's edits would stamp out those 
of another. That's not the case. Google Drive enables two 
or more people to work on a document at the same time 
without there being too many problems. And you can view 
what they're doing as they type, as shown below:

The cursor for each of your collaborators is assigned a 
color — you're usually lime green and the other people 
who have access to the document are assigned colors 
quite arbitrarily. For example, the cursor for the 
collaborator on the document used for the example above 
is shaded pink. You'll notice that the Google Drive user 
name of your collaborator appears above the cursor.

You can also use the comment feature (described above) 
as a rudimentary instant messaging tool. Just add a 
comment to something a collaborator has added, and use 
the comment thread to discuss it. 

There's an example of this on the next page.
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Sending Your Work to Editors ... and 
Others
If you write for a living, there comes a time when you'll 
need to send what you've written to someone. That 
someone can be an editor at a publication or a publishing 
house, a production person, or just someone who will read 
your work.

You can use the collaboration features that I discussed in 
the previous chapter to do that, but not everyone is 
comfortable using Google Drive. They might not want to 
learn how to use it, either.

Luckily, those collaboration features aren't the only game 
in town. Let's take a look at a couple of ways in which you 
send your work in Google Drive to others.

Going Old School

Remember when I showed you how to download your files 
in Google Drive as actual word processor files? Doing that 
is often the easiest way of sending someone your work. 

Just download the document that you want to send and 
then compose a new message in your email software or 
web-based email service like Gmail or Yahoo! Mail. From 
there, attach the file that you downloaded to the message 
and click Send.

As you might recall, you can download documents from 
Google Drive in a variety of formats. Before you download 
and email a file, contact the person to whom you intend to 
send to document. Ask them which file format they're most 
comfortable with. Most likely, that will be Microsoft Word. 
Asking is a nicety, but one which minimizes any frustration 
on the part of your recipient.
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Sending Documents from Within Google 
Drive

Instead of downloading and emailing a document, why not 
send it from within Google Drive? Doing this can save you 
time and doesn't clutter your computer with a bunch of 
files.

How do you send documents from within Google Drive? 
Open the document that you want to send and then select 
File > Email as attachment. Doing that opens the 
following window:

It looks like an email window, doesn't it? That's exactly 
what it is. Google Drive uses Gmail (Google's web-based 
email service) to send the files.

To get going, choose the type of file that you want to send 
from the Attach as list. You can send files in the formats 
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that in the chapter "Backing Up Your Documents." As I 
mentioned earlier, Word is often your safest bet for sending 
your documents.

Then, enter the email address of the person to whom you 
want to send the file in the To field. Add a descriptive 
subject for the email in the Subject field, include a short 
message, and then click the Send button. The message 
and the attachment will show up in the recipient's inbox.

I use this feature to send articles to editors and have had 
no problems with it. Keep in mind that you need a Gmail 
account to use this feature — you'll obviously have that if 
you're using Google Drive. On top of that, the message 
(and the attachment) will not appear in the Sent Mail folder 
of your Gmail account. If you're worried that the document 
wasn't sent, it's worthwhile following up with the recipient. 
It's a little extra work, but it's worth the peace of mind.
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Taking Notes with Scratchpad
Taking notes is the life blood of writers. Ideas, research, 
observation, links, and more. We all need to jot down 
information as quickly and as efficiently as possible.

Just as there are many reasons for taking notes, there are 
many ways to do it. Especially online. With Google Drive, 
it's easy to take and organize your notes. I explain how to 
do this in my ebook Getting Organized with Google's Tools. 
But having to jump from one browser tab or window to 
another to take notes can really disrupt your flow.

Instead, why not have a smaller window handy? One that 
will let you save your notes to Google Drive, and yet only 
get in your way when you need it to. You can do that with 
an extension for the Chrome web browser called 
Scratchpad.

Getting Going

You'll need the Chrome web browser to use Scratchpad. If 
you don't already use it, and are curious or want to switch 
from the browser that you use, you can download Chrome 
and give it a try.

Next, go to the Chome Web Store and install Scratchpad. 
When you're done, it appears on one of Chrome's 
application screens, as shown on the next page.
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Note: If you use a Chromebook (a small laptop computer 
running Google's Chrome OS that's designed for working 
on the web), then Scratchpad is already installed.

Click the icon to launch Scratchpad. It exists as a small 
window that floats in the background until you need it.

Using Scratchpad

In the Scratchpad window, click the pencil symbol in the 
top-left corner. This creates a new note (called, for some 
reason or another, a message).

From there, you can:

• Type your thoughts.

• Copy and past a link to an interesting site, article, 
or blog post.

• Jot down anything that you comes to mind.

Working in Scratchpad is just like using a text editor or a 
word processor. If you need to, you can add character 
formatting, change the font and size of the font, and create 
a bulleted or numbered list using the toolbar at the bottom 
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of the note window.

Remember to rename the note — the default name, 
Untitled message, won't mean anything when you're trying 
to find a specific note. To rename a note, click Untitled 
message at the top of the window and start typing.

Try to give your notes a descriptive name which reflects 
their content. Like what? Say you're working on an article 
about productivity apps for mobile devices and you've 
collected a bunch of links into a Scratchpad note. You can, 
for example, name the note Links for mobile productivity 
apps article. That's not the most exciting title, but it works.

Scratchpad automatically saves your notes to Google 
Drive. You can return to the list of notes in Scratchpad by 
clicking the list icon in the top-left corner of the window.

Getting to Your Notes

Of course, notes are only good if you know where they are. 
And there are actually two places where you can find the 
notes that you took with Scratchpad.

The first place, obviously, is in the Scratchpad window. In 
the list view, just click the name of the note that you want 
to view. The note opens, and you can add to it or copy and 
paste from it.

The second place is in Google Drive. When you install 
Scratchpad, it creates a new folder in your Google Drive 
account called Scratchpad. 

Click on the name of the Scratchpad folder, and you get a 
list of all of your notes. To open a note, click its name. The 
note opens in a Google Drive editing window.
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Taking Notes with Google Keep
In the previous chapter, I introduced Scratchpad. It’s a 
small, simple tool for taking notes and saving them to 
Google Drive. While Scratchpad is good for taking simple 
text notes, you might want to do a bit more. There are a 
number of web-based note taking applications out there – 
tools like Evernote, Simplenote, and Catch.

Each of those tools, and many like them, are useful, 
flexible, and pack any number of features. But if you like 
keeping your web-based tools under one umbrella, then 
you’ll want to take a close look at Google Keep.

Google Keep inhabits the middle ground between a 
powerful note taking tool like Evernote and a more basic 
tool like Simplenote. That said, Keep lacks a few features 
like the ability to:

• Organize your notes in folders or using tags (which 
are keywords that identify content and which can 
be used to search and filter it).

• Attach files, like PDFs, to a note.
• Save your notes in Drive, as you would with 

Scratchpad.

Those are some of the things that Google Keep can’t do. 
Let’s take a look at what it can do.
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Simplicity is the Core Feature

That simplicity starts with the interface. Google Keep’s 
interface is, as you can see below, is both quirky and 
spartan.

The interface is simple both in appearance and in its ease 
of use. And it doesn’t take too long to adapt to that 
interface, either.

Let’s take a look at how to use Google Keep to take and 
maintain notes.

Creating a Note

Creating a note is easy. Just click in the Type note field at 
the top of the Google Keep page. It expands to let you add 
a title to the note, along with whatever content you want to 
type.

There’s no limit to the amount of text that you can include 
in a note. However, you can’t add formatting (like bullets or 
bold text) to a note in the way that you can with 
Scratchpad.
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You can also attach an image to a note by clicking the 
Insert an image button. From there, click the Choose an 
image to upload button. Find an image on your computer, 
and then click the Done button to save it.

It’s Not Just Text and Images

You’re not limited to creating only plain text notes with the 
occasional image embedded into them. You can also 
create checklists. To do that, click the New list button.

The list can contain as few or as many items as you need. 
When you type in the space for an item in the list, Google 
Keep automatically adds a line below it. Click in the space 
marked Add new and start typing. Keep doing that until 
you have all the items in your checklist.

When you want to mark an item as done, click the 
checkbox beside that item.

What good is a checklist? You can use it for just about 
anything. I use checklists as to do lists or as a 
pre-publication check for an ebook or article. The example 
below is the checklist that I used when preparing the 
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second edition of this book.

Going mobile

In many ways, Google Keep seems to be designed mainly 
for the mobile world. There’s an Android app for 
smartphones and tablets available from the Google Play 
store.

And you don’t need to be connected to the internet or a 
wireless network to use the Google Keep app. If you take 
notes while offline, they’ll be synchronized to Google Drive 
then next time you’re connected to the internet.

The design of that app mirrors the spartan interface of the 
desktop version.
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Even though it’s designed for a different kind of device, the 
mobile version of Google Keep works the same way as the 
web-based version. Instead of clicking, you tap to add a 
note, image, or list.

Notice, though, there are four types of notes that you can 
create with the mobile app:
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You can create a text note, a checklist, a voice note, and a 
photo note. You know about the first two types of notes, 
but let’s look at taking voice and photo notes.

Voice and Photo Notes

You can record and save a voice note or take a photo and 
save it as a note. Admittedly, this isn’t anything new – the 
mobile versions of several other note taking tools have had 
this capability for a while.

Taking a Voice Note

With a voice note, Google Keep will try to transcribe what 
you’re recording in the body of the note. The transcriptions 
don’t always work well – you’ll either get an approximation 
of the recording or something completely different. That 
said, you can replay recordings within a note.

To take a voice note, tap the microphone icon. Then, start 
speaking. When you stop speaking, the app saves the 
recording, tries to transcribe it, and embeds an audio 
player in the note.
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The only problem is that if you pause for too long, the app 
thinks that you’ve stop speaking and saves the note. This 
can get frustrating.

Taking a Photo Note

A photo note is just that: an image that you take with the 
camera on your device, and to which you can add text. Not 
on to the photo itself, but below the photo as a caption.

To take a photo note, tap the camera icon. Point your 
device at whatever you want to take a photo of and then 
tap the big blue button on the screen.

The Google Keep app saves the photo, and you can add a 
title and some text. Use that text to describe the photo, 
where you took it, or when you took it.

Sharing

Not only is the app’s interface designed for mobile, but 
Google Keep is also nicely integrated into the Android 
Share menu. This enables you to save, for example, the 
address of a web page or some text that you’ve highlighted 
in an ebook or on a web page to Google Keep.

To do that, highlight some text in an ebook or tap and hold 
the URL of a web page in a web browser. Or, as in the 
example on the next page, hold and drag some text in an 
application.
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Then, tap the menu icon and select Share. You’re 
presented with a list of applications on your device. Tap 
Keep, and the note is instantly added to Google Keep.
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Two Other Useful Features

Google Keep also has a pair of features you’ll find useful. 
You can delete and archive your notes, and search them.

Let’s take a look at both those features.

Deleting and Archiving Your Notes

As time goes on, you’ll undoubtedly collect a large number 
of notes. There’s nothing wrong with that. Taking notes and 
collecting information is part and parcel with being a writer.

But thanks to the freeform nature of Google Keep, you 
wind up with a note after note after note. That can lead to a 
lot of clutter in Google Keep, especially if you no longer 
need many (or just some) of those notes.

To clear out that clutter, you can delete or archive notes 
that you no longer want or need.

To do that, hover over a note. A pair of icons appear.

Click or tap the Delete button (the trash can) and the note 
is gone. It’s history. You’ll never see it again. Remember to 
click or tap Delete with caution.

But if you know that you’ll use that note in the future, why 
not archive it? Archiving a note moves it out of the main list 
of notes in Google Keep. Click or tap the Archive button, 
and the note you selected vanishes.

Well, at least out of the main list of notes. If you scroll 
down to the bottom of the Google Keep page, you’ll see a 
button labeled Archived notes. Click it to jump to the 
Archived Notes view. 
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Here’s a sample:

You can view, edit, and delete notes on this page. You can 
also click the Restore button to move the note back into 
the main list in Google Keep.

Searching Your Notes

As I mentioned at the beginning of this chapter, Google 
Keep doesn’t give you a way to organize notes. It’s quite 
free form – notes are listed in chronological order, the 
newest at the top.

Google Keep does, however, have a search function that 
narrows down the list of notes based on the word or 
phrase that you type in the search box at the top of the 
page.

Let’s say I want to find a note related to this book. I type 
google drive in the search box and press Enter. Keep 
comes back with all the notes containing the words google 
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and drive, as shown below:

Searches don’t, however, come back with archived notes. 
You’ll have to go to the Archived Notes view and do a 
search from there.
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Working Offline
In some of the images in this book, you may have noticed 
the word Offline beside the names of documents, like the 
ones below: 

While Google Drive is a web-based application that 
requires an internet connection for you to use it, you can 
also use Google Drive when you don't have a connection. 
That can be when, for example, you're working away from 
your home or office and don't have a wireless connection. 
Or you might be on an airplane and want to get some work 
done before arriving at your destination.

You don't need to let your thoughts and words slip away or 
to scramble for pen and paper. Instead, you can take 
Google Drive offline with you. Let's look at how to do that.

Taking Your Documents Offline

First off, I should warn you that there's one catch to taking 
your documents offline: you need to be using Chrome 
(Google's web browser) on your computer or the Google 
Drive app for your tablet or smartphone. It won't work with 
anything else.

The first step to taking your documents offline is to enable 
offline access. To do that, click More in the menu on the 
left side of the Google Drive window. Then, click Offline 
Documents. 
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The My Drive portion of your browser window changes to 
this view:

Click the Enable Offline Docs button. You're almost ready 
to go. If you haven't done so, you should install the Google 
Drive extension for the Chrome web browser. It's free, and 
enables you to manage your documents when you're 
offline.

You will need to enable offline docs for every computer that 
you use — for example, I had to do that with my laptop and 
my Chromebook.

Once you've done that, Google Drive synchronizes your 
documents for offline use on your computer. Depending on 
the number of documents that you have, this could take a 
while. While you will be able to view documents and 
spreadsheets offline, you can only edit documents.

Editing Your Documents

When you don't have an internet connection, go to 
https://docs.google.com/offline. There, you get a 
condensed view of My Drive, listing all of the documents 
that are synchronized for viewing and editing offline. 

Just click on the name of the document that you want to 
edit and it will open in the same editing window that you're 
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used to when working online. 

You can make changes to the document and save it. Once 
you're back online, your changes will be uploaded the next 
time you go to Google Drive.

Using Google Drive's offline access can cause problems if 
the document that you're working on is shared with others, 
and those others have been editing the document while 
you've been offline. When your document is uploaded to 
Google Drive, it will replace any previous version. There's 
no way you can avoid this happening. But you can use 
Google Drive's change tracking feature (which was 
explained in the chapter Collaborating with Others) to 
recover any changes that your collaborators have made.

Disabling Offline Access

You might find that you don't do too much, or any, work 
offline. If you need to, you can turn off the offline feature. 
To do that, click the gear icon in the top-left corner of the 
Google Drive window and select Stop Using Offline 
Docs.

A new page opens in your browser.
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Click the Disable Offline Docs button. Your documents 
and files are not longer available when you don't have an 
internet connection.

As you did when you enable the offline feature, you'll need 
to disable offline docs on every computer for which it's 
enabled.
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Storing Files in Google Drive
Google Drive is for more than creating and editing 
documents (and other work). As its name suggests, 
Google Drive is like a web-based hard drive where you can 
store files. And not just word processor documents, 
spreadsheets, and presentations.

You can upload just about any type of file to Google Drive. 
Photos, audio, video, archives, and more. It's easy to do. 
All it takes is a few clicks.

Let's take a look at how to store files in Google Drive.

Why Do It?

It's convenient, it's fairly safe, and you get 5 GB of free 
storage. You can also buy more space if you need it.

For writers, it's important to have your writing and any 
other related information in one place. It's part of being 
organized and makes finding the information that you need 
easier when you need to find it. 

What could that information be? For example, it could be 
notes or information that you've typed into a text file. It 
could be articles you've downloaded. Or it could be 
handwritten notes that you've scanned. If you have that 
information on your desktop computer, but need it when 
you're using a laptop or tablet then that information isn't 
much use to you. By putting it in Google Drive, it's there 
when you need it.

You probably don't want to put all of your files in Google 
Drive. Especially not files with personal or sensitive 
information. While Google Drive is secure, there's no 
guarantee that your account or the service itself won't get 
hacked. Choose what files that you want to save to Google 
Drive carefully.

92



Before You Begin

If you plan to store files in Google Drive, don't just upload 
them to My Drive. Instead, remember the lessons in the 
chapter "Organizing Your Work". Create folders and sub 
folders for the files that you want to upload. Give those 
folders and sub folders descriptive names.

And if you plan to save notes related to a specific 
document or a project to Google Drive, keep that 
information with the document or project to which it relates. 
Again, use descriptively-named folders and sub folders to 
better organize any additional information.

Uploading Files

Let's assume that you've created a folder for the files that 
you want to store in Google Drive. Navigate to that folder 
and click the Upload button on the left side of the Google 
Drive window.

Notice that you can upload either files or a folder from your 
computer. Let's assume that you want to upload a file. 
Select Files. You'll be asked to locate the file that you want 
to upload on your computer. You can upload multiple files 
at the sample time by clicking them and pressing the CTRL 
key on your keyboard.
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Click OK. Google Drive will ask you to confirm two 
settings:

• Convert documents, presentations, spreadsheets, 
and drawings to their Google Docs formats.

• Convert text from PDF and image files to Google 
documents.

If you only want to store files in Google Drive, clear the 
check boxes beside each setting. Then, click the Start 
upload button. Depending on the number of files that 
you're uploading, the size of those files, and the speed of 
your internet connection, the upload can take anywhere 
from a few seconds to a few minutes.

Note: The process for uploading a folder to Google Drive is 
the same as what I've just described.

Downloading Stored Files or Folders

So what happens if you want to pull a file or a folder that 
you're storing in Google Docs on to your computer? You 
can do that easily.

Find the file or folder that you want to download. Then, 
right click on it and select Download from the menu that 
flies out. Google Drive transfers the files to your computer.

You can also download multiple files to your computer. 
Click the check boxes beside the name of each file, and 
then right click and select Download from the menu that 
flies out. 

A window opens letting you specify how you want Google 
Drive to backup up your documents. With files that aren't 
documents — like videos, PDF files, audio files, or photos 
— there's only one option: As Is. From there, click the 
Download button. Google Drive compresses the files into 
an archive and downloads it to your computer.
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What about downloading a folder? Do the same thing. 
Again, you'll be asked to tell Google Drive what file formats 
you want to use for the contents of the folder. In many 
cases, the only option you'll have is As Is. After you click 
the Download button, Google Drive compresses the folder 
into an archive and downloads it to your computer with a 
name like [name_of_folder]-[date].zip — for example, 
Templates-2012-10-12.zip.
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Using A Spreadsheet With Your 
Writing
When most people think of spreadsheets, images of 
number crunchers and bean counters probably come to 
mind. Well, spreadsheets usually conjure those images for 
me …

While spreadsheets don’t have a lot to do with actually 
writing, they’re more than just a financial tool. Writers can 
use spreadsheets in some very useful ways. So useful that 
spreadsheets can increase your productivity.

The main ways in which you can can use a spreadsheet 
include:

• Keeping track of queries and submissions.
• Keeping on top of your earnings.
• Recording the progress of a larger writing project, 

or one on which you’re collaborating with others.

Let’s take a look at how to do all of that. But before we do, 
let’s go over at how to create a spreadsheet.

Creating a New Spreadsheet

If you’re familiar with spreadsheets in general, and the 
Spreadsheets feature in Google Drive in particular, then 
feel free to skip to the next section. But if you’re new to 
spreadsheets or need a quick refresher, then read next few 
paragraphs. I’ll be outlining some basics of using a 
spreadsheet.

On the My Drive page, click the Create button and then 
click Spreadsheet. You’re presented with a blank canvas 
that consists of a number of vertical columns and 
horizontal rows, as shown on the next page.
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The columns and rows allow you to group information. For 
example, let’s say you’re creating spreadsheet to track 
your submissions. You can title the first column of your 
spreadsheet Publication Name. Each row in that column 
can contain the name of a publication. Here’s an example:
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You’ll notice that the columns are assigned letters, starting 
with A, and that the rows are numbered. The letters and 
numbers help you navigate through a spreadsheet. So, for 
example, if I say C13 you know to go to the 13th row in the 
third column. This will come in handy later.

You’ll also notice something like this at the bottom of a new 
spreadsheet:

Clicking the + button adds a new tab to the spreadsheet. 
You can use tabs to, for example, track submissions for 
each month of a year – one tab per month.

New tabs are labeled Sheet 1, Sheet 2, and the like. 
Those names aren’t helpful. To make them helpful, rename 
the tabs. To rename a tab, click on the downward-facing 
triangle on the tab and select Rename.
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Then, type a new name for the tab.

The menu that appears when you click the triangle 
contains a few other items. The items that you’ll probably 
use most are Duplicate (which makes a copy of the 
current tab) and Delete (which gets rid of a tab).

What about formatting? Like a document, you can change 
the font and style of text in a spreadsheet, add borders, 
change the format of numbers and dates, and add 
functions (which automatically do math, among other 
things). I’ll be discussing the most important function that 
you’ll use in the section Tracking Your Earnings later in 
this chapter.

With that out of the way, let’s start off by taking a look at 
how to use a spreadsheet to keep track of your queries 
and submissions.

Tracking Your Queries and Submissions

If you send out more than a couple of queries or 
submissions (whether solicited or not) a week, you know 
that keeping track of them can be difficult. A spreadsheet 
is, as you’ve probably guessed, a great way to keep track 
of your queries and submissions.

There are several ways in which you can do that. I’m going 
to share with you the way in which I use a spreadsheet to 
track queries and submissions. This spreadsheet is not 
only easy to use and maintain, it’s reusable.

Start off by creating a new spreadsheet. Then, rename the 
spreadsheet – for example, Queries - 2013. I break my 
queries and submissions down by month; one tab per 
month. So, rename the tab from Sheet1 to January

Next, add the following column headings:

• Publication - The name of the publication (print or 
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online) to which you submitted the query or 
manuscript.

• Contact - The name of the editor or staff member 
you are dealing with.

• Title/Subject of Article - The title or the subject of 
the article.

• Date Sent - The date on which you sent the query 
or submission.

• Reply Received - The date on which you received 
a reply from the publication.

• Status - I use either Rejected or Assigned.

Once you’ve set up the first tab, duplicated it 11 times (one 
tab for each subsequent month). Then, rename each tab. 
Next year, you can make a copy of the spreadsheet, 
rename it, and delete the contents of each tab.

You can find a sample of this spreadsheet, which you can 
use and modify, here.

Tracking Your Earnings

While writing can be fun and mentally and emotionally 
rewarding, it’s also the way in which many of us earn a 
living. To keep your accountant (and the taxman) happy, 
it’s a good idea to keep track of your earnings.

Let’s put together an earnings tracking spreadsheet. Like 
the one we created to track queries and submissions, this 
one is simple to use and maintain. It’s also reusable.

Start by creating a new spreadsheet. Rename the 
spreadsheet to, for example, Earnings - 2013.

It’s best if you track your earnings monthly. So, rename the 
tab from Sheet1 to January. Then, add the following 
column headings:

• Publication/Client, which is the source of the 
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earnings (whether a print or online publication, or a 
corporate client).

• Amount, which is the amount you earned.
• Contact, which lists the person at the publication or 

the client with whom you were dealing.
• Date of Invoice, which is the date on which you 

sent the invoice. This is useful when a payment is 
late.

• Date Payment Received, which is the date on 
which you received a cheque, a bank transfer, or a 
payment via a service like PayPal.

That’s all quite straightforward. Let’s get a little more 
complex and look at formatting the numbers in the 
Amount column.

Say, for example, you garner income from 10 different 
sources each month. You can set up each tab to track and 
tally those earnings.

Start off by clicking the second row in the Amount column 
and, while holding the mouse key down, drag the mouse 
down to row 11. Then, click the Format as Currency 
button (the dollar sign) on the toolbar. When you enter a 
number in any of the cells of the column, that number will 
be a figure like $150.00.

You’ll also want to have a running total of your earnings for 
the month. To do that, you can insert a function into the 
spreadsheet. As I mentioned earlier, functions perform 
mathematical operations. In this case, adding up the 
figures in the Amount column.

Go to row 13 in the Amount column. In row 13, type 
=SUM(B2:B11). Let’s break this function down. =SUM tells 
the spreadsheet to add up the numbers in the column. B2 
is the second row (2) of the second column, while B11 is 
the eleventh row of the second column. The colon (:) tells 
the spreadsheet to add all the values in rows B2 to B11.
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Once you’ve set up the first tab, duplicated it 11 times (one 
time for each subsequent month). Then, rename each tab.

You can find a sample of this spreadsheet, which you can 
use and modify, here.

Tracking Your Expenses

As hard as we may try not to, every writer has to spend 
money from time to time. Yes, those pesky expenses. 
There’s always something, and you need to make a habit 
of keeping track of those expenses. Here’s one way to do it 
with a Google Drive spreadsheet.

The first step is to figure out what your expenses actually 
are. My loose definition of an expense is anything that 
enables me to work or to find business. Of course, that’s 
open to interpretation and it’s important not to go crazy 
silly. How? For example, thinking that your weekly 
groceries or the morning latte that kick starts your day are 
business expenses. They aren’t. Well, maybe the latte …

But you can claim things like a portion of my mobile phone 
bill, subscriptions to online applications, new business 
cards, and Internet use as business expenses. They all fit 
the definition in the last paragraph.

Using Google Drive allows you to edit and update your 
expenses spreadsheet no matter where you are. If you 
have an accountant, you can publish that spreadsheet for 
him or her to see, or just email it to them from within 
Google Drive.

The expense spreadsheet I use is simple. In fact, it’s 
based on the earnings spreadsheet that we created in the 
last section. Let’s look at how to set it up.

Create a new spreadsheet. As with the earning 
spreadsheet, it’s best if you track your expanses monthly. 
So, rename the tab from Sheet1 to January. Then, add 
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the following column headings:

• Description - A description of the expense.
• Vendor - The name of the merchant (online or 

bricks and mortar) with whom the expense was 
incurred.

• Type - The type of expense – for example, a 
computer hardware or an ebook.

• Date - The date on which the expense was 
incurred.

• Amount - The amount that you spent.

As with the earnings spreadsheet, format the Amount 
column to display as currency. Then, add a running total to 
the bottom of the Amount column using the =SUM() 
function. See the explanation in the last section to learn 
how to use this function.

Once you’ve set up the first tab, duplicated it 11 times (one 
tab for each subsequent month). Then, rename each tab.

You can find a sample of this spreadsheet, which you can 
use and modify, here.

Recording the Progress of a Writing 
Project

Maybe you’re writing something big, like a book. A 
spreadsheet can help you keep track of what you’re doing 
and where you are in the writing process. You’ll have to 
remember to update the spreadsheet, but that’s all part of 
the discipline of writing.

When writing a book, for example, you can set up 
individual tabs for each chapter. Then, use the 
spreadsheet to track:

• The status of that chapter – for example, In 
Progress, Draft Completed, or Pending.
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• The target page or word count of that chapter.
• The current page or word count.
• The estimated date of completion.
• Any supporting notes you might have.

The information that you put into the spreadsheet will, of 
course, vary depending on what you’re writing.

With a collaborative project, the concept is the same. You 
might want one worksheet on a spreadsheet for each 
person involved in the project. The individual worksheets 
can list the work done, the status of current work, the 
estimated completion date, and any notes. Of course, 
you’ll need to share that spreadsheet with your 
collaborators.

Sharing a Spreadsheet

I really don’t like passing files around by email. Things get 
lost or mixed up or corrupted. Using Google Drive 
minimizes the chance of file snafus, and allows you and 
your collaborators (if any) to access the spreadsheets 
anytime and from anywhere.

Why share a spreadsheet? Doing that offers a level of 
transparency to everyone involved in a project. Each 
person working on the project can track everyone else’s 
progress.

To share a spreadsheet, first open it. Then, follow the 
instructions in the chapter Sending Your Work to Editors 
… And Others.

While a spreadsheet doesn’t help you write, it can help you 
keep track of your writing as well as of your expenses and 
earnings. The Spreadsheet feature in Google Drive is quite 
flexible, and easy to use. And it’s available wherever you 
are.

104



105



Final Thoughts
It's not the tool. It's the writer.

I've been saying that for years, and I believe it. If your 
words aren't true, if they aren't accurate, or if they're not 
chosen properly then the finest software, service, or device 
won't make you a better writer. 

Having said that, a good piece of software or a good 
service or a good device can make you a more efficient 
and more flexible writer. Google Drive fits that bill. It lets 
you work anywhere and with anyone. Using Google Drive, 
I've been able to work more efficiently and get more writing 
done. There's no reason you can't do that too.

I hope you've found this book useful. And I hope that it's 
helped you learn more about some of Google Drive's 
features for writers and others.

If you have any comments, suggestions, or corrections feel 
free to contact me. You can find my contact information at 
the end of this book.
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Links
Through this book, I’ve included a number of links to 
various resources on the web. If you’ve printed this book, 
or are using it while offline, those links aren’t a lot of use to 
you.

This appendix lists all of those links. You can type them or 
copy them into your browser. Note that some of the links 
have been shortened to make typing them easier. 

Google Drive: http://drive.google.com

Google Scholar: http://scholar.google.com

Google Drive offline: http://drive.google.com/offline

Google Takeout: http://www.google.com/takeout

Gmail: http://mail.google.com

Chrome Web Browser: https://www.google.com/chrome/

Chrome Web Store: 
https://chrome.google.com/webstore/category/home

Scratchpad: http://goo.gl/qPVf7

Google Drive template gallery: 
http://drive.google.com/templates 

Google Keep: http://drive.google.com/keep 

Google Keep Android app: http://goo.gl/BVB0l 

Sample ebook chapter template: http://goo.gl/C7GEY 

Sample query tracking spreadsheet: http://goo.gl/vN2xi 

Sample earnings tracking spreadsheet: 
http://goo.gl/lW2CY 

Sample expenses tracking spreadsheet: 
http://goo.gl/bm757

Chromebook: http://www.google.com/intl/en/chromebook/
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Google Drive extension for Chrome: http://goo.gl/fyxLN

Google Drive app for Android: http://goo.gl/8RctM

Google Drive app for iPhone and iPad: 
http://goo.gl/2vp5J 

Getting Organized with Google's Tools: 
http://goo.gl/B9KTZ

LibreOffice: http://www.libreoffice.org/

Zamzar: http://www.zamzar.com/

Acrobat Reader: http://goo.gl/h7OQW

Evernote: http://www.evernote.com 

Simplenote: http://www.simplenote.com 

Catch: http://www.catch.com
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